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Introduction to EndNote X4

1 Introduction
EndNote is one of a number of Personal Reference Database programs that are in use around the world today. The

main functions of such programs are:

• Maintaining a database of references;
• Downloading references from other databases;
• Using the database to link to references in word-processed documents; and
• Generating a bibliography in the correct style for publication.

UC Davis has a campus-wide license allowing all current UC Davis students, faculty and staff to install and use
EndNote on computers at work and at home. To download Endnote, go to

http://my.ucdavis.edu/software
To learn more about EndNote at UCD, you should go to the UCD Library EndNote page at

http://www.lib.ucdavis.edu/dept/instruc/research/endnote/index.php
This guide aims to show you the basic skills required to get started using EndNote version X4. It does not cover
everything you will ever need to know. If you want to learn more, or learn about something in particular that is not
covered here, visit theEndNote web page above, or use the help feature of EndNote. EndNote has many useful help
screens that can be accessed by clicking on the Help item on the menu bar at the top of the screen or the Help button

on the main toolbar.
There is also a very detailed manual for EndNote X4. It will be installed on your computer along with the EndNote

software. The manual is clearly written and well indexed. The default location of the manual on your computer is:
C:\Program Files (x86)\EndNote X4\GettingStartedGuide.pdf

You will need software such as Adobe Reader to read it.
The following resources can provide additional support and information.

• EndNote provides email and phone support for questions related to using EndNote software. To get it, start at
the web page

http://www.endnote.com/support/entechform.asp
• Contact IT Express for support downloading and installing EndNote on your computer.

http://itexpress.ucdavis.edu/
• The UC Davis University Library provides support for questions related to getting started using EndNote soft-

ware with library research resources. Please use the EndNote email service request form and indicate your
research subject area so the appropriate EndNote liaison can contact you.

http://www.lib.ucdavis.edu/dept/instruc/research/endnote/ask.php

This document assumes you’re using the Windows 7 operating system. EndNote X4 is compatible with Windows
XP, Vista, and 7. EndNote X4 is also available for the Macintosh, and is compatible with versions of MacOS X 10.3.9
and beyond (including 10.6). The Macintosh version is very similar to the Windows version; you should have no
trouble following this document using it.

1.1 Notation and Terminology

In this document, when you see a command like Edit>Preferences>Libraries, click on the Edit menu item,
go to the Preferences entry in that menu, and then on the menu that pops up, go to the Libraries entry, and release the
mouse button.

“Library” is the term used by EndNote to describe a file where you have stored a database of references. A library
can contain up to 100,000 references. Multiple libraries can be maintained, but generally there is no need to do this.
All references can be kept in the one library, and labelled or indexed to reflect any particular subject interest.

You can set up a default library, which will open automatically when you open EndNote. To do this, select:
Edit>Preferences>Libraries.

Finally, you’ll need to do a few things differently if you’re not in the labs. In this document, we’ve identified these
differences. To keep things simple, we’ll refer to “at home” when you’re not at the lab, but you should follow those
steps when you are anywhere except at the lab.
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1.2 Compatibility with Earlier Versions

Beware: EndNote X4 is compatible with EndNote 8, 9, and other versions of EndNote X, but it is not compatible with
EndNote 7 and earlier versions. If you use EndNote on more than one computer, make sure that you have the same
version of EndNote on all computers. If you collaborate with colleagues, make sure that they are all using EndNote 8
or a later version.

2 Opening EndNote
If you are in the labs: Go to Start>All Programs>Class Software>EndNote>EndNote Program.
If you are at home: Go to Start>Programs>EndNote>EndNote Program, or locate the EndNote Program icon on
your Start menu or desktop.

You may at this point see a box asking if you want to create a free subscription to EndNote Web. If you see this,
click on “Cancel”. If you don’t see it, don’t worry.

You should at this point see the dialogue box in Figure 1.

Figure 1: Initial Dialogue Box

3 Setting Up a New Reference Library
Cliock on the picture next to Create a new library. You will see the following dialogue box (Figure 2), with “My

EndNote Library” as the name of the new library.
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Figure 2: New Library Dialogue Box

Click on the Desktop icon in the leftmost part of the window; this will save the library on the Desktop. In the File
name box, type project for the name for your library. This should replace “My EndNote Library”; if it doesn’t, just
delete it. Then click on “Save”. You should see Figure 3.

Figure 3: New Library Window

The Preview Pane at the bottom of the library window will show you what your formatted references look like. To
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close the Preview Pane, click on “Hide Tab Pane” at the lower right of the “project.enl” window.

More about EndNote Libraries

The file extension “.enl” stands for “EndNote Library”. A library is just a file on your computer, like any
other file. It can be copied, renamed, deleted, moved to another folder or compressed.

It is very important to make back-up copies of your library regularly and store them on another drive. An easy
way to back up your library is to go to File on the menu bar, and select Compressed Library (.enlx) . . . .

When EndNote creates the library, it will also create a .DATA folder which contains various files connected with
the library. When you copy the library, you should also copy the .DATA folder.

The library window can be resized or maximized, like any other window.

4 Displaying the Toolbars
You can enter many commands in two ways: either through the menus or using the toolbars. Here, we’ll use the

toolbars because they are simpler. But if you find them confusing, you should use the menus.

• The Main toolbar is available at the top of the library window.

• The Text Style Toolbar, which appears at the top of the window when you create or edit a reference, is not used
very frequently. You should use it only when your references contain text that must always appear in italics
(such as a species name) or with subscripts (for example, a chemical formula).

• The CWYW/Add-in toolbar contains commands that can also be accessed in Microsoft Word, and is used when
you’re running EndNote in combination with Microsoft Word.

You will see more about these toolbars as we go along.

5 Inputting References Manually

Click on the “New Reference” button on the main toolbar. You should now see Figure 4.

Figure 4: New Reference Window
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Note that Journal Article is the default Reference Type. Click on the arrow at the end of the Journal Article
pull-down menu box to see the other reference types (such as Book, Conference Proceedings, Map, Web Page, etc.)

With Journal Article as the type in the Reference Type box, input the details for the article in Figure 5. Use the Tab
key to go from one field to the next, or click in the next field with the mouse.

When you have finished typing the data for your reference, it should look something like Figure 5.

Figure 5: Journal Article Reference

Close the reference by clicking on the button in the top right-hand corner of the New Reference window. You will
be asked if you want to save the changes you made to the reference (see Figure 6). Click on the “Yes” button to do so.

Figure 6: Dialogue Box for Saving a Reference

Practice entering a reference for a conference paper using the information from Figure 7. Remember to select the
appropriate Reference Type, and then input the data. It should look something like Figure 7.

Version of January 3, 2011 at 11:59pm Page 5 of 24



ECS 15, Introduction to Computers Winter Quarter 2011

Figure 7: Conference Paper Reference

When you are done, close the reference and save it.

“Garbage In, Garbage Out”

Later you will learn about the EndNote output styles. These convert the data in your library into references
that are properly formatted for publication. The output styles can only format your data correctly if you have entered
the data correctly in your library.

Here are some important points to remember when entering data:
• If there is more than one author, each author must be entered on a separate line.
• Corporate authors must be entered with a comma at the end, as in “University of California,” (note the trailing

comma).
• When you enter your reference, just enter the basic data, in the default EndNote font. The output style will

change this to bold or italics as necessary and add extra text such as “vol.” or “Ed.” as required by the style.
• Fields such as Keywords, Abstract, and Notes are for your use. These fields can each store up to sixteen pages

of text.
• Use the URL field to link to an electronic version of the document on the web.
• Use the Link to PDF field to link to a PDF version of the document stored on your own computer.
• If you use abbreviated journal titles in your publications, you can set up a “term list” to store the abbreviations.

You can go to the manual or to the UC Davis Library EndNote website
http://www.lib.ucdavis.edu/dept/instruc/research/endnote/

to learn more about this.

6 Editing References in EndNote
In the library window, double-click on one of the references that you have entered. This will open it for editing.
You can change any of the details. Add some text to the Notes field of the conference paper now. Close the

reference when you have finished editing and save the changes.
If you want to delete a reference from your library, click on it once in the library window to select it, and then go

to References on the menu bar, and select Move References to Trash. Do not delete either of the examples!
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7 Importing Downloaded References with a Filter
A filter is a piece of software that will take a file of references which have been downloaded from a database and

convert them into references in your EndNote library.
The file of references must be in plain text (*.txt) and must be split up into labelled fields, something like this:
AU: Smith, J.
TI: New developments in instructional software
SO: Journal of Educational Technology, vol. 3 (2001): 305-318
A filter is specific to a particular database (e.g. Medline, Psycinfo). When the database is marketed by more

than one vendor, separate filters will be required for each vendor’s version of the database (e.g. Medline from Ovid,
Medline from SilverPlatter, Medline from CSA).

You can use a filter to import references directly from the web or from a file.

7.1 Importing References from a Database

We’ll use the “INSPEC [via Web of Knowledge]” database to show you how to do this. You need to have EndNote
running and your library open for what follows.

First, we’ll select the references to download. Open a web browser and go to the UCD Library Database page at
http://www.lib.ucdavis.edu/ul/research/databases/

Look for the database. You can either search for it, or click on the icon with “I” and scroll down until you find it
(Figure 8.

Figure 8: UC Davis Library Window with INSPEC

If you are doing this from home: The use of most of these databases is restricted to authorized UC Davis users. You
need to log into the campus system using the VPN. To do this, click on the small icon next to the INSPEC hyperlink
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. If you are not yet logged in, the system will ask you to sign in using your campus username and password. It
will then take you directly to the search page for that database.

Next, perform a search and select any two references. As an example, we’ll type “computer security” in the
“topics” field and “denning d*” in the “author” field; the result of the search, and the two entries we selected, are
shown in Figure 9.

Figure 9: INSPEC Window Showing Selections

Click on the button and follow the directions. (If your web browser downloads
something that ends in “.cgi”, or asks to do so, then your web browser isn’t set up to do this. Switch to another
browser.)

Now switch back to your EndNote library. You will see the references in a window as shown in Figure 10:
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Figure 10: Imported References Window

If you want to see the full library, click on “All References” at the left.

7.2 Importing References from a File

We’ll use the “PsychINFO [via CSA Illumina]” database for this example. The procedure for getting the references
is similar to the one for INSPEC, above. Go to the UCD Library Database page as before, and find the database.
Perform a search and check the references you want to put into your EndNote library. Then:

• Click on the “Save, Print, Email” hyperlink just above the list of references.

• Just above the Comments: box, make sure the pulldown menu says Full format.

• Find the “Save”, and make sure the File format: is set to “PC”. The click on the “Save” button. Remember
where the file is (for this handout, assume it is on the desktop, and is called “csaresults”).

Click on the “import” button on the main toolbar. You should see a dialogue box that looks like Figure 11.

Figure 11: Import Dialogue Box

Now click on the “Choose . . . ” button. Locate and highlight the file of references that you downloaded. Click on
the “Open” button to select the file. This will return you to the previous dialogue box.
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In the pulldown menu labelled Import Option, click on the down arrow to see some of the standard import options.
Then click on Other Filters to open the list of filters (Figure 12).

Figure 12: Filters List

Browse down the list of databases until you find the “PsychINFO (CSA)” filter, since you obtained the records
from that database. (If it is not in the filter list, pick any filter with “(CSA)” in it. The figures will look a bit different,
though.) Highlight the filter and click on the “Choose” button. This will return you to the previous dialogue box.

Next, in the Duplicates: pulldown menu, select Import into Duplicates Library. In the Text Translation pulldown
menu, use the default No Translation; it is appropriate in most cases. The dialogue box should now look something
like Figure 13.
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Figure 13: Import Dialogue Box

Click on the “Import” button and the references will be imported. As before, you will see only the references
which you have just imported in the library window.

More on filtering references

After filtering, only the references which you have just imported will be visible in the library window. To see
all the references in the EndNote library, either click on “All References” in the left part of the window, or on
References>Show All References.

No filter is perfect, and all references should be checked after import. For this reason, it is often better to import
references into a temporary library, and leave them there until they can be checked against the file of downloaded
references and, if necessary, fixed. They can then be transferred to the permanent library.

8 Connecting Directly to Databases over the Internet

FIrst, create a temporary library by clicking on the “Online Search Mode (Temporary Library)” button . We’ll
explain why in a moment.

Click on the Connect button on the main toolbar. A list of available connection files will appear (Figure 14).
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Figure 14: Connection Files List

Scroll down the list of databases until you find “U Calif-Davis”. (If it isn’t there, pick any other database to which
you have access, and use it instead. Again, some of the figures will look a bit different, and the search described below
may return a different number of results.) Highlight it and click the “Choose” button. EndNote will use your Internet
connection to access the database. You may need to enter your campus username and password. When the connection
is successfully established, EndNote opens a pane in the library window labeled Online Search - Library Catalog at
University of California-Davis. Your screen should look like Figure 15.
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Figure 15: The Connection File Search Window

Enter a search term in the first search box. You can select the appropriate Boolean operator to the left of the next
search box, and enter a second term in that search box. The pane shows 3 search boxes. If you need more, click on the

“add” button next to the last box. To delete a search box and its contents, click on the “delete” button .
For this example, we put “bester” in the first search box (the one labeled Author in the pulldown box to the left)

and “demolished man” in the second box (and changed the pulldown menu entry to the left to Title). Your screen
should now look something like Figure 16.

Figure 16: Constructing a Search with a Connection File
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(If you get fewer than 2 references, pick some other terms. For what follows, you need more than 5 references.)
Now click on the “Search” button. You may see a bar labeled Search; and you will see a dialogue box stating the
number of references which match your search (Figure 17).

Figure 17: “Confirm Remote Search” Dialogue Box

To retrieve the first five references, change the figure in the second box to 5. Then click on the “OK” button. The
references will be displayed in the Retrieved References window (Figure 18).

Figure 18: The Retrieved References Window

You can double-click on any of these references to open them and view the full details.
When you do a search, all the found entries are added to your library automatically. In general, you’ll only

want some of the references that result from your search. That’s why you created a temporary library to hold all
the references your search found. To transfer a reference from the temporary library to your local one, highlight the

reference and click on the “Copy to Local Library” button .
If you wish to search the database again, you can simply delete what is in the search boxes, change the pulldown

menus as needed, and type in your new search words. Or, you can close the temporary library and create a new one.
When you close the temporary library, you will be asked to confirm that you want to discard the retrieved references.
Clicking “Yes” only deletes the ones in the temporary library, and not any that have been transferred into your local
library. So, you should click “Yes”.
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If you want to search a new database, close the temporary library, click on the “Connect” button . Then proceed
as before.

More on connection files . . .

In addition to the connection files that you can download from the UC Davis Library EndNote website, you
can use many of the connection files supplied with the EndNote software. Databases such as PubMed and library
catalogues are freely accessible without a password.

Boolean operators are processed strictly in the order of input. So if you are looking for material on “Forestry in
Indonesia and Malaysia”, you must construct your search as “Indonesia OR Malaysia AND forestry”. If you input the
search “forestry AND Indonesia OR Malaysia” you will retrieve every record on the database which includes the term
“Malaysia”.

As with filters, the connection files do not always import data accurately. All references should be checked after
import.

9 Copying References between Libraries
If you have more than one library, moving references from one library to another is easy.
Your library “project” should already be open. We will now open another library called “Paleo” (a large library

containing references on paleontology). It is available in the Assignment 1 area of SmartSite, or you can download it
from

http://nob.cs.ucdavis.edu/classes/ecs015-2007-02/lab1/manuscript.doc .

From the menu bar at the top of the EndNote window, choose Open>Open Library .... This will bring up a
dialogue box. Find and select the library “Paleo”, and open it by clicking on the button “Open”.

You now have two libraries open. The easiest way to copy references is to tile the libraries, so that they appear
side by side. To do this, click on Window>Tile Vertically. If you see the preview panes rather than the list of

references, click on the “Hide Tab Pane” at the lower right of each window. Your screen should
look like Figure 19:

Figure 19: Two Libraries in Tile Format

To copy a reference from the Paleo library into your library, click on the reference to highlight it. Then click on it
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again and drag and drop it into your library. Copy the Cosgrove 1947 “Caves of the Upper Gila” to your Project.enl.
To ease your search for Cosgrove, you can click on category headings to sort according them. A year sort works quite
well for this particular search. Click on the “Year” column, and EndNote will sort the entries in the “Paleo” library by
year. The Cosgrove paper is the fifth from the top of the window.

You can select a group of references and drag and drop them in the same way. Remember that to select a group of
adjacent references you must hold down the SHIFT key, but to select references which are not adjacent, you must hold
down the CTRL key.

10 Searching an EndNote Library
EndNote provides a sophisticated search function that allows you to locate specific references or groups of refer-

ences in your library. We will practice this, using the “Paleo” library. We recommend you close the “project” library;
otherwise, your window may be cluttered.

To begin a search, click on the “Show Tab Pane” button at the lower right of the “Paleo”
window. Then look at the three tabs at the top of the pane; if “Search” is not the frontmost one, click on it. Change the
first pulldown menu in the “Search” pane to Any Field and type “sediment” in the search box to the right. You should
see something like Figure 20:

Figure 20: Searching an EndNote Library

Click the “Search” button. This searches the entries for “sediment”. As we did not check the Match Words box,
we are searching for the string of letters “sediment” and not just for the word “sediment”. So, for example, a field
containing “sedimentary” would be matched. You should see 22 references, as in Figure 21. If you just see the search
pane, click on the “Enlarge Window” button next to the “Close Window” button in the upper right corner of
the “Paleo” window.
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Figure 21: Searching an EndNote Library

Let’s do a more complicated search. We wish to find all references by Jones published in 1990 or later. So we need
to find references which have “Jones” in the Author field, and a number greater than or equal to 1990 in the Year field.

Go to the “Search” pane (if it’s not showing, click on the “Show Tab pane” button ). Make
sure the first pulldown box on the first line says Author, the second box says Contains, and type Jones in the third
box. Go to the second line; set the Boolean connector in the leftmost pulldown menu to And, the next pulldown box to
Year and the last to Is greater than or equal to. Type 1990 in the next box. You should see something like Figure 22:

Figure 22: Constructing a Boolean Search of an EndNote Library
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Click on the Search button. You should retrieve two references. Neither of these references has Jones as the first
author, but if you open the references, you will find that they both have Jones as a collaborating author.

11 Sorting an EndNote Library
When you open a library, it automatically sorts itself alphabetically by author. However you can sort your refer-

ences on any of the fields in the record, such as author, title, year, or label. You can also use secondary fields to sort,
for example, by year and within each year, by author.

We’ll again use “Paleo” as the sample library.
If you want to sort by any of the fields named in the window above the list of references, simply click on the field

name. For example, to sort by year, click on the “Year” field. You will see the references reordered, with the earliest
year first (see Figure 23).

Figure 23: References sorted by year, earliest year first

If you want to change to order to latest year first, click on the “Year” field again (Figure 24). Note that the little
arrowhead that is at the top of the field name now points down; that indicates the sorting is from latest to earliest.

Version of January 3, 2011 at 11:59pm Page 18 of 24



ECS 15, Introduction to Computers Winter Quarter 2011

Figure 24: References sorted by year, earliest year first

Now, let’s do a more general sort, by author name and with a secondary field of year. Go to Tools>Sort Library
.... The following screen (Figure 25) will appear:

Figure 25: The “Sort Options” Dialogue Box

In the first pulldown menu, click on the arrow to select Author. At the end of the box is a button which indicates
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whether you wish to sort items from first to last or last to first . Click on this button to change it to sort from
first to last (that is, from ‘A’ to ‘Z’). In the second pulldown menu, click on the arrow to select Year and leave the
default setting to sort from last to first (that is, from most recent to earliest). The resulting sort will sort the references
by author, with multiple references by the same author sorted by year.

The box should now look like Figure 26.

Figure 26: The “Sort Options” Dialogue Box

Click on the OK button and the references in the library will now be sorted chronologically, with the most recent
references first.

12 Producing a Bibliography or Reading List
An EndNote output style (often just referred to as a style) is a piece of software that will convert the data in your

library into formatted references that correspond to the bibliographical styles used by journal publishers or specified
in style manuals such as the Chicago Manual of Style.

Hundreds of output styles are supplied with the software, so there is a good chance that you will find one suitable
for your needs. If not, EndNote allows you to create your own output styles or change an existing output style.

To start off, we consider how to use the references in your library to generate a reading list for students, or a list of
references for a colleague, or perhaps a list of your own publications for your CV.

While holding down the CTRL key, select five references from your library.
Click on References>Show Selected References in the menu bar. You should now see only those references

which you selected. At this point, you could sort the references if you wished them to appear in your bibliography in
a different order.

Next, you have to decide on the bibliographic style that you wish to use for your references. Go to the style menu

on the main toolbar and click on the arrow. You will see a list of the four basic EndNote styles.
Click on Select Another Style to open the complete list of output styles that are supplied with the EndNote software
(Figure 27):
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Figure 27: Output Styles List

Find the APA 5th style, and then click on it to highlight it. Click on the “Choose” button to select that style.
This will return you to the library window, with only your selected references showing. To generate a bibliography

from these references, using the style that you have just selected, click on the Export button on the main toolbar.
You will now see a dialogue box. Save the exported references to a convenient folder. In the Save as type pulldown
menu, click on the arrow to select Rich Text Format (*.rtf). Name the file “ProjectBib.rtf”. Finally, click on the “Save”
button. To view the bibliography, open your word processor and then open the file which you have just saved.

13 Using EndNote with a Word Processor
You will now practice using Cite While You Write by adding some references to a sample paper. You will find a

word document called “manuscript.doc” in the Assignment 1 area of SmartSite, or you can download it from
http://nob.cs.ucdavis.edu/classes/ecs015-2007-02/lab1/manuscript.doc

Is my word processor compatible with EndNote X4?

For Windows users, EndNote X4 is compatible with Microsoft Word 2000 and later, using Cite While You
Write (as explained below). On the Macintosh, EndNote X is compatible with Microsoft Word X and Word 2004,
again using Cite While You Write. If you are using an earlier version of Word, or another word processor, you must
save your documents in Rich Text Format and use the RTF Document Scan function (see the EndNote X4 Help for
more information).

We have just seen how to use EndNote to create an independent bibliography. EndNote can also work in conjunc-
tion with your word processor, so that you can insert references as you type a document, and automatically generate
the bibliography.

If you have a compatible version of Microsoft Word on either Windows or Macintosh installed on your computer
at home, when you install the EndNote software, two extra files will be inserted into your word processing software.
In what follows, we use Microsoft Word 2007, which is compatible with EndNote X4.

If you are running Microsoft Word 2003 or earlier, you need to run “Run EndNote in Word.com”; for example, in
the labs this is available at Start>All Programs>Class Software> EndNote>Run EndNote in Word.com. Run
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this program. Then start Microsoft Word and on the menu bar, click on Tools¿EndNote X. You should see some
additional commands relating to EndNote.

Open “manuscript.doc” using Microsoft Word 2007. In the top menu bar, click on EndNote X4. This displays the
EndNote toolbar. It should look like Figure 28:

Figure 28: The EndNote Toolbar in Microsoft Word

If you are running Microsoft Word 2007 and do not see this, quit Microsoft Word and run “Run EndNote in
Word.com” as described above. Then restart Microsoft Word 2007. You should see the EndNote toolbar now. We
have noticed that, in the labs, this is necessary.

If you position your mouse over any of the buttons on the toolbar, a text box will appear showing the name of the
button and some information about what the button does.

13.1 Formatting References in an Author-Date Style

What is an “author-date style”?

The Harvard Style is the best-known author-date style, but there are many variations. In the text of the paper,
the reference is cited in an abbreviated form similar to “ . . . (Smith, 1993)”. In the list of references at the end of the
paper, references are given in full and listed alphabetically by author.

Open “manuscript.doc”.

We need to decide which style we wish to use. Click on the “Go to EndNote” button on the

toolbar. In EndNote, go to the style menu on the main EndNote toolbar. (If APA 5th is not showing,
click on the arrow, select Select Another Style to open the complete list of styles, browse through the list to find the
APA 5th style and choose it.) This is the output style corresponding to the fifth edition of the American Psychological
Association’s Publication Manual. It is a commonly used author-date style.

Now go back to Word, and check that the Style: box says APA 5th. If it does not, click on the arrow and select APA

5th. Next, click on the “Insert Citation” button above the word “Insert”. In the box that appears, type the name of
an author in the search box (for example, “Budd”). Then click the “Find” button. EndNote will display the matching
references (Figure 29).
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Figure 29: The “Insert Citations” Search Window

Click on the “Insert button”, and this reference will be inserted into your document. EndNote will instantly format
the citation in the text and produce a list of references at the end of the document in the APA style. Insert a line with
the word “References” above the reference. Your document might now look something like this:

Recent Developments in Personal Bibliographic Software: a Critical Review
By J.W. Bloggs

Since the 1980s, there have been a variety of software products on the market which can be classified under
the general heading of Personal Bibliographic Software (Budd, 1988). All of these products perform the same two
basic functions: they allow the user to maintain a database of bibliographic references and they permit the generation
of a bibliography containing some or all of those references. Among others, Glaser has provided a good summary of
the products currently on offer.

Substantial developments have taken place in the functionality of personal bibliographic software. Today it is
not difficult to find a product that can automatically import references from a database and format both in-text
citations and a list of references in a wide variety of styles.

References

Budd, D. A. (1988). Aragonite-to-calcite transformation during fresh-water diagenesis of carbonates - Insights
from pore-water chemistry. Geological Society of America Bulletin, 100(8), 1260.

We shall now add some more references to this paper.
At the end of the second sentence in your Word document, insert a space before the full stop and again click on the

“Insert Citation” button . Search for another reference, using the author’s name or some words from the title. Select
and highlight a reference, and click on the “Insert” button.

As an alternative to using the “Insert Citation” command, you can click on the “Go to EndNote” button
and select references directly from your library. Highlight a reference in the library window and click the “Insert Cita-

tion” button in EndNote X4. You will be flipped back to the Microsoft Word window, with the reference you chose
inserted.

Save the changes that you have made to your paper.
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13.2 Formatting References in a Numbered Style

What is a “numbered style”?

In a numbered style, references are indicated by a number in the text. The number is often printed as a su-
perscript. At the end of the paper, the references are listed and arranged by the numbers that they have been
assigned.

Do not confuse a numbered style with a footnote (or endnote) style. Footnote (or endnote) styles number the
footnotes (or endnotes). The references are then inserted into the footnotes (or endnotes), along with other text.

We will change the style of the references in the paper you have already formatted to a numbered style. This
situation could arise if you decided to submit the article to a different journal or conference. Go back to Word, and
change that the Style: box to say Nature. EndNote will reformat your document with the new style. It might now look
something like this:

Recent Developments in Personal Bibliographic Software: a Critical Review
By J.W. Bloggs

Since the 1980s, there have been a variety of software products on the market which can be classified under
the general heading of Personal Bibliographic Software1. All of these products perform the same two basic functions:
they allow the user to maintain a database of bibliographic references and they permit the generation of a bibliography
containing some or all of those references2. Among others, Glaser has provided a good summary of the products
currently on offer.

Substantial developments have taken place in the functionality of personal bibliographic software3. Today it is
not difficult to find a product that can automatically import references from a database and format both in-text
citations and a list of references in a wide variety of styles.

References

1 D.A. Budd, Geological Society of America Bulletin 100 (8), 1260 (1988).
2 S. Guerrak, Journal of African Earth Sciences and the Middle East 7 (3), 50 (1998).
3 D. S. Sepich, D. C. Myers, R. Short et al., Genesis 27 (4), 159 (2000).

The format of the references may differ, but all should be at the end of the document.
Now that you are done creating “Project.enl” and “manuscript.doc”, you should store them in your MySpace, just

in case you need them again. You get to MySpace by selecting the “Connect to MySpace” icon on the Desktop. After
you have stored it in MySpace, go to SmartSite, and submit both files to ECS 15. In SmartSite, you would go to your
ECS 15 workspace, then to Assignments, and submit Lab 1.

After submitting the two files, you are done. Don’t forget to delete the files you downloaded, and then use the Start
button to logout from the lab computers!
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